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Introduction 
 

This document has been written to facilitate the use of modelling software by students and 

researchers in biology. The writing of this document has been motivated by the will to 

gather practical information in one document. Our handbook describes how to install and 

run software to simulate and visualize RNA folding. We will not go deep into the details of 

how the software works. There are alternatives to our software choices.  

We are three studeŶts froŵ “up’BioteĐh, a ďioteĐhŶologǇ eŶgiŶeeriŶg sĐhool just outside of 

Paris, France, in Villejuif. We are part of the iGEM IONIS-PARIS 2017 team. The project we 

will present at the Giant Jamboree relies on a plasmid that will give bacteria the ability to 

express specific proteins as a function of temperature. We aim to make the bacteria produce 

a particular protein only at low temperatures (~10-15°C) and another protein only at high 

temperatures (~38-42°C). Here we will describe only the molecular modeling of the 

regulatory RNA sequence responsible for cold induced expression. 

The cold sensing mechanism relies on the formation of specific structures at low 

temperatures due to stabilization of specific types of RNA, more generally called RNA 

thermometers. The translation of cspA (cold-shock protein A of E. coli) is thought to be 

depeŶdeŶt oŶ the ĐoŶforŵatioŶ of the ĐspA ϱ’UTR. The ŵaiŶ hǇpothesis is that at high 
teŵperature ;arouŶd ϯϳ°CͿ the ĐspA ϱ’UTR is rapidlǇ degraded, preǀeŶtiŶg ĐspA eǆpressioŶ.  
At loǁ teŵperature ;ďeloǁ ϭϱ°CͿ the ĐspA ϱ’UTR is staďle aŶd differentially favors ribosome 

binding, likely through enhanced recognition of ribosomal protein S1 in the pre-initiation 

complex. Since RNA conformation and stability are difficult to study experimentally, we 

decided to model it computationally using the SimRNA software package1.  

We used “iŵRNA to geŶerate a ϯD ŵodel of the ϱ’ UTR of the ĐspA ŵRNA to studǇ its 
possible structure. Our work also led us to use several additional modeling software 

packages such as GROMACS 2and VMD3. We wrote this handbook to help the iGEM 

community avoid the delays we faced early in our modeling work. 

                                                           
1 MiĐhal BoŶieĐki aŶd al., ͞“iŵRNA: A Coarse-Grained Method for RNA Folding Simulations and 3D Structure 

PrediĐtioŶ,͟ aĐĐessed JulǇ ϮϬ, ϮϬϭϳ, https://ǁǁǁ.ŶĐďi.Ŷlŵ.Ŷih.goǀ/pŵĐ/artiĐles/PMCϰϴϯϴϯ51/. 
2 Mark James Abrahaŵ et al., ͞GROMAC“: High PerforŵaŶĐe MoleĐular “iŵulatioŶs through Multi-Level 

Parallelisŵ froŵ Laptops to “uperĐoŵputers,͟ SoftwareX 1–2 (September 2015): 19–25, 

https://doi.org/10.1016/j.softx.2015.06.001. 
3 Williaŵ HuŵphreǇ, AŶdreǁ Dalke, aŶd Klaus “ĐhulteŶ, ͞VMD: Visual MoleĐular DǇŶaŵiĐs,͟ Journal of 

Molecular Graphics 14, no. 1 (February 1, 1996): 33–38, https://doi.org/10.1016/0263-7855(96)00018-5. 
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The following document will start by explaining the principle and use of the SimRNA 

software to do the RNA simulation. It will be followed by the conversion of the SimRNA 

results into files readable by VMD using GROMACS. Finally, we will talk about the use of 

VMD for visualization and analysis. 

For additional information, please contact us at: ionis.igem@gmail.com or visit our wiki: 

http://2017.igem.org/Team:IONIS-PARIS . 

Software installation and command line basics on Linux 
To run our simulations, we used a personal gaming PC running Linux 16.04 LTS.  

Specs: 

CPU: Intel Core i7 6700K @ 4.00GHz  

RAM: 16.0 GB Dual-Channel DDR4  

Graphics card: NVIDIA GeForce GTX 1070 - 8GB 

Motherboard: ASUSTeK COMPUTER INC. Z170 PRO GAMING (LGA1151) 

 

VNC (Virtual Network Computing) 

Virtual Network Computing is a type of software that will allow the access of your server via the 

internet from anywhere in the world. In our case, it allowed us to manage our simulations (some of 

which took several days to complete) remotely. 

Today several VNC software implementations are available; some are free, but for convenience we 

used VNC connect from RealVNC with the free trial. They have easy to follow tutorials for installation 

and VNC configuration. 

 

SimRNA 

To download SimRNA for Linux go to: ftp://ftp.genesilico.pl/pub/software/simrna/. Choose the file 

that suits your machine and extract it.  

It’s doŶe! ;easǇ huh?Ϳ 

VMD 

You will find all the versions of VMD available on this website:  

http://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=VMD 

To download VMD you need to create a free VMD user account. Then extract the installation file. 

mailto:ionis.igem@gmail.com
http://2017.igem.org/Team:IONIS-PARIS
https://www.realvnc.com/en/?_ga=2.11833204.1526733250.1508916396-245840153.1508916396
ftp://ftp.genesilico.pl/pub/software/simrna/
http://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=VMD
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GROMACS 

Before setting up GROMACS, run those three prerequisite installations:  

sudo apt-get install cmake  

sudo apt-get install make 

sudo apt-get install build-essential gcc 

To install GROMACS, go on http://manual.gromacs.org/documentation/. Choose the package you 

want to install (for ou simulations we used the 2016.3 version) and extract the archive on the 

desktop. 

Open a terminal and navigate to the new GROMACS folder with this line:  

cd path_to_gromacs_folder.  

 

Then make a new directory with mkdir build and enter in this new directory cd build.  

Noǁ, let’s get serious:  

CMake will allow to choose the options to add to your own GROMACS compiled version. The options 

will depend on your hardware and your software.  

Some usefull options:  

- If you are using a multi-threading processor you can build GROMACS with MPIsupport: -

DGMX_MPI=on 

 

- If you are using a NVIDIA graphics card with CUDA GPU acceleration you can add:  

-DGMX_GPU=on. We advise you to install the CUDA toolkit and add to your CMake 

command: -DCUDA_TOOLKIT_ROOT_DIR=path_to_cuda_toolkit_folder (usually 

/usr/local/cuda). 

 

- To allow you to do the benchmark add to your CMake command:  

-DREGRESSIONTEST_DOWNLOAD=on and -DMGX_BUILD_OWN_FFTW=on. 

For more options, we advise you to refer to the GROMACS manual iŶ the seĐtioŶ ͞TǇpiĐal 
iŶstallatioŶ͟.  

 

 

 

 

For our CMake command we have: cmake ..-DGMX_MPI=on -

DCUDA_TOOLKIT_ROOT_DIR=/usr/local/cuda -

DREGRESSIONTEST_DOWNLOAD=on -DMGX_BUILD_OWN_FFTW=on 

http://manual.gromacs.org/documentation/
https://developer.nvidia.com/cuda-toolkit
http://manual.gromacs.org/documentation/2016.3/install-guide/index.html#cmake-options
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Then run three commands: 

make 

make check 

sudo make install 

Then to launch GROMACS just run gmx in a terminal. 

Simulations and rendering  

Run a simulation 

 Isotemperature simulations 

 To run a simulation, you can refer to the section 3 of the SimRNA User Manual and use the 

appropriate command. In our experiments we used a .txt file but you can also use a .seq or a PDB file.  

 

 

-c : it gives  a config file.  

AŶd theŶ ǁait… ฀ (Depending on system size and hardware specifications, this could take up to 

several days for a large RNA, such as ours of ~190 nucleotides).  

Once the simulation is finished you can have a quick view of the results ǁith TraflVieǁ, “iŵRNA’s 
built in trajectory viewer. Then if you want to get a .vmd movie of the RNA folding continue to 

Extract the .trafl and the .xtc . 

 

 

 

 REMC (Replica Exchange Monte Carlo) simulations 

For the REMC simulationsjust use the same previous code and add -E that allows to specify the 

number of replicas you want.  

Code for a .txt file: SimRNA -s input_file_seq -c config_file 

Figure  SEQ Figure \* ARABIC 1 Example of a config file 

Code: traflView output.trafl output.bonds  
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DoŶ’t forget to ŵodifǇ the ĐoŶfig file to Đhoose Ǉour teŵperature raŶge.  

Once the simulation is finished, you have to do the clustering: 

Begin by concatenate all the trafl. Go into the trafl directory (cd trafl_folder).  

And run in a terminal: cat *.trafl > output.trafl 

Go back into the SimRNA root folder:  

clustering trajectory.trafl X.X X.X >& remc_clust.log 

- >& remc_clust.log : allow to generate a log file 

 

- X.X indicate the percentage of the lowest energy molecule that will be included into the 

clustering. If X.X = 0.01 it means that 1% of the lowest energy frames of the generated trafl 

will be included in the cluster. 

Each trafl can be transformed into xtc by following the section Extract the .trafl and the .xtc. As 

the reference pdb for the trafl2pdbs command you can use the first pdb file generated by the 

simulation. No matter the temperature of the first pdb file, the simulation always begins with a 

circular RNA.  

Extracting the trajectory files : .trafl and .xtc 

 

After the simulation, the program output that interests us is the TRAFL, that is a trajectory 

file. We now have to extract the PDB files from the trafl. Every PDB file represent one frame 

of the simulation. 

 

Code: ./SimRNA_trafl2pdbs input_file.pdb output_trafl_file.trafl 000:000 AA 

 

- input_file.pdb: It corresponds to the PDB file that you gave to SimRNA to begin the 

simulation.  

 

- output_trafl_file.trafl: It is the TRAFL fil that SimRNA generated at the end of the 

simulation 

 

- 000:000: Optional. It allows to choose the frames we want to extract into PDB files. It 

can be useful if your total number of frame is over 1020. Indeed, we didn’t succeed in 
extracting more than this number of frame in one time.  

 

- AA: Optional. This allow to render a PDB file of each frame with a full atom 

reconstruction. All the file generated will be named as follow: _AA.pdb 
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Each frame, with the AA option, will generate 2 PDB files and 1 ss_detected file. 

Then isolate all the _AA.pdb files in a directory with the command:  

  

Those commands will create a new folder “AA_pdb”, move all the AA pdb files in it, and clean 

the original folder from all the .pdb & .ss_detected files. 

Generate the .xtc file, another trajectory file, which is supported by VMD.  

You need to use GROMACS and work in the directory where the _AA.pdb files are stored.   

 

 Code : gmx trjcat -f *AA.pdb -o file_name.xtc -cat 

- -f *.pdb : the -f is used to give the name of the input file. The *AA.pdb allow to 

concatenate all the _AA.pdb files into the .xtc file.  

 

- -o file_name.xtc: the -o is used to give the name of the output file.  

 

- -cat : allow to concatenate all the frames. 

Visualization on VMD 

 

The visualization part can be done either on windows or Linux.  

 
Tips : To launch VMD on linux just write vmd in a terminal. 

Code : cd ./your_pdb_folder 

 mkdir AA_pdb 

mv *AA.pdb ./AA_pdb 

rm *.pdb & rm *.ss_detected  

 

 



 

RNA SIMULATION AND ANALYSIS  

  

 

 

G.CHRISTIEN, N.DELETTRE, T.LHERNOULD, A.ISMAIL 8 

 

Open VMD and load the first AA pdb file of the simulation. Then load the xtc file. It could take a while 

but to accelerate the process you can hide the molecule. For that you double click on the name of 

the molecule:  

File > Load Data into Molecule… 

 

Verify you Load files for your molecule and Browse the xtc.  
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VMD will load all the frames of your molecule, if you have a large number of frame you can hide the 

molecule in order to accelerate the loading process:  

Graphics > Representation > Delete Rep. At the end of the loading process you can follow the same 

path and chose Create Rep in order to visualize the molecule.  

 

Center the molecule: 

 

    Extensions > Analysis > RMSD Trajectory Tool 
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     Write ͞all͟ and press Align. 

Then to reset the view and put the molecule in the center press ͞=͟ oŶ Ǉour keǇďoard or go to 
Display > Reset view.   

 

 

Video making on Windows  

 

First, you must download the VideoMach software. It is used by VMD to render the movie. 

Unlike what VMD tells you, the free version works just fine, no need to pay $20 per month. 

Once it is done. Load your PDB and your XTC as previously described. 

 

Now, Select Extensions → Visualization → Movie Maker. 

http://gromada.com/main/download.php
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Set the output directory and the movie name. 

 

In the menu Movie Settings, select the option Trajectory, you cannot edit the movie duration 

when you are recording a trajectory. 
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Press “MAKE A MOVIE”. 

Wait until step 2/8 is complete (it renders all your frames into screenshots). 

 

 

When asked, indicate the pathway towards VideoMach executable (videomach.exe). 
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It is probably “C:\Program Files (x86)\VideoMach\videomach.exe”. 

 

VideoMach will analyze the image sequence, just wait a bit. 

 

Just hit the start button to launch the final rendering. 
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Just wait until the end of the process. 

 

 

You should get your movie at the selected directory. 
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